
                CCA-101: Fundamentals of IT & Programming 

                                       Assignment - 1 

Q1: What are the four fundamental parts of computer? Explain it with the help 

of diagram. 

Ans: Monitor, Keyboard, Mouse, CPU. 

 

Q2: Discuss about the classification of computers based on size and 

capacity. 

Ans: 1. Super Computer: The most efficient computers in terms of processing 

data & performance are supercomputer. They are exceedingly large and 

highly expensive. They are the fastest and strongest. They process 

information at rapid rate. 

2.Mainframe Computer: Despite being less than super computer. They have 

enormous amounts of memory. They have significant number of CPUs with 

powerful processing speed. 

3.Mini Computer:  This computers are small in size, less costly. It is able to 

perform many jobs at once. It also used in business. 

4.Micro Computer: They are smaller and comparably less expensive. It has 

limited computational capacity. It is also called Personal Computer (PC). 

 

Q3: What is the meaning of computer generation? How many Computer 

Generations are 

defined? What technologies were/are used? 

 



Ans: Computer gen based on the major technological changes in the 

hardware of computer. There are five generation of computer like 1.Vacuum 

tube(1940-1956) 2. Transistor (1956- 1963) 3. Integrated Circuit (1964- 1971)   

4. Microprocessor (1971- 2010) 5. Artificial Intelligence {AI} (2010 Present & 

Beyond)  

 

Q4: Differentiate between Volatile & Non- Volatile memories. 

Ans: 

 

 

Q5: Distinguish among system software, application software and open-

source software on the 

basis of their features. 

Ans: 

System Software Application Software Open- Source Software 
System Software is written in low 
level language. 

Application software is written in high 
level language. 

Historically evolved from free 
software. 

The size of system software is 
smaller. 

Application software requires more 
storage space than system software. 

Opensource grants 4-freedom (run, 
study, distribute & modify). 

System software is complex to 
understand. 

Application software is easy to build in 
comparison to system software. 

Opensource Initiative License (OSI). 

System software is present near 

hardware components. 

Only single task is performed by each 
application software. 

Open source has a copyright holder. 
 

 

 

Q6. a) Create a file in MS-word to insert a paragraph about yourself and save 

it with file name 

“yourself”. Describe all steps involved in it. 

Q6 b) Write steps regarding followings 

1. 

2. 

3. 

4. 

                       Volatile                  Non- Volatile 

Loses its contents when the power is 
turned off. 

Does not lose contents when power 
is turned off. 

Requires consistent flow of power to 
retain data. 

Does not require consistent flow of 
power to retain data. 

Affects the system performance. Affects the system storage. 

Faster.  
Ex. RAM 

Slower. 
Ex.  ROM, hard disk, floppy memory. 



 To change the font style 

 To change the font size 

 To change the font colour 

 To highlight (in yellow) the line that reads “need to get IMS’s address”.      

 Ans:   My name is Pranay Ganesh Shigwan. In family we are three 

members including me. My father name is Ganesh Shigwan & mother name is 

Sheetal Shigwan. My father works at PNVL in Shivam medical. My mother is 

housewife. I pass 12th exam in 2023. I like to play cricket & other games.  My 

dream is become a successful person in future. My current address is At. 

Ladiwali  post.Gulsunde, tal.Panvel, dist.Raigad.         

 

Q7. Create a file in MS-Word for the following document and save it with file 

name ‘MS-word’. Describe 

 

  ISRO Organisation 

             Present  

 

   SCIENCE EXHIBITION  
  (SCIENCE MODELS) 

   

 

Date: 21/ 06/ 2023 
Time: 11:00 am 
                                    
            The main aim of this exhibition is inspired to students and give chance to 

make their future bright.  In this exhibition we placed best of best science models. We try 

to spread information about universe in students. In this exhibition there are practical for 
students, ques game and many more. From this exhibition they should understand new things, 
knowing information. Information about India’s great scientist also give in this exhibition. To 
know more information come to this exhibition on given date. 
   
 Address: 
Mumbai East ,22 
Andheri West 410 207 
ISRO Centre 
Near Anand Hotel.          
  ISRO@GMAIL.COM                                  
 
 
 
 
 
 
 



 
Q8. Create a file in MS-word for the following document and save it with file name ‘equations’. Describe 
all steps involved in it. 
        
   Equation  
   X2 + Y5 = 30 

      Z3 + Q 4 = 50 
  A2+ B8= X2+Y8 
ANS:  Equation 

           
           X2 + Y5 = 30 

                      Z3 + Q 4 = 50 
        A2+ B8= X2+Y8 

 
Q9. Create a file in MS-word that convert existing highlight text to table as shown below and 
save it as 
file name ‘text _to table’. Describe all steps involved in it. 
Ans:    
             

Computer gen based on the major technological changes in the hardware of computer. There 
are five generation of computers. 

 
Q10. Create a file in MS-Word to insert a table in the document. Describe all steps involved in it. 
  
Ans:  Open the MS – word and click on insert (table command). There are two types of choosing 
table first one is select table row or column wise & second is Draw the table using pencil. 
 
Q11. Create a following worksheet in MS-excel and save it with name ‘book1’. 
{Answer of this question is complete in excel} 
 
 
Q12. Q12. Calculate the following things of a range (C2:C11) of data in the worksheet created in 
question no 
11. 

 the sum of the marks using AutoSum in a range of cells (C2:C11) 
 average of the marks in a range of cells (C2:C11) 
 highest marks in a range of cells (C2:C11) 
 minimum marks in a range of cells (C2:C11) 

 {Answer is completed in Excel} 
 
Q13 a) Describe various steps involved in the following 

 To modify column width of a worksheet 
 To modify the row height of a worksheet 
 To delete rows and columns of a worksheet 

 
Q13 b) Describe following terms in the worksheet 
 

 Absolute reference and relative reference in formula 
 Cell address 

  Ans:  



   
b) Cell address: A cell address is an alphanumeric value used to identify a specific cell in 
worksheet. It consists of one or more followed by a number. Ex, A1 is the cell address of the 
first cell in first column & row of a spreadsheet. 
 
Q14. a) What tools are available to customize our PowerPoint presentation? 
 
Q14 b) Write the steps for the following action for creation of power point presentation 

 Open a Blank presentation 
 Save the presentation as Lab1.pptx 
 Add a Title to the first slide: the name of your college 
 Type your first name and last name in the Subtitle section 
 Add a New Slide which has a Title and Content 

  
Ans: a) There are several tools available to customize power point presentation, ex; templates 
& themes, slide layouts, fonts, colour themes, icons, shapes, stock photos, charts & graphs. 
 {Answer of (b) is complete in PPT}. 
 
 Q15. Write steps for creation of a set of PowerPoint slides that demonstrates your skill to use 
the tools of PowerPoint. It should include the following things 

 Title slide &bullet list 
 Inserting Excel Sheet 
 Clip art and Text 
 Slide show effects 

Ans: 
1.  Open PowerPoint and click on the Home tab. 
2. Click on New Slide and select Title Slide. 
3. Add a title and bullet list by clicking on the Text Box icon in the Insert tab. 
4. To insert an Excel sheet, you can either copy and paste the data from Excel worksheet into 

PowerPoint slide or link/embed an Excel worksheet into PowerPoint. Here are the steps for both: 
o Copy and paste Excel data into PowerPoint: 

1. Copy the data from Excel worksheet. 
2. Go to PowerPoint slide where you want to insert the data. 
3. Click on Paste in the Home tab. 

o Link/embed an Excel worksheet into PowerPoint: 

Absolute reference Relative reference 

Absolute reference is cell reference made 
constant by adding the dollar ($) sign before 
column name & row no. 
 

Relative reference is the default cell 
reference in Excel. 

If  either the row or the column is made 
constant then it is known as a mixed 
reference. 
 

Relative reference change when a formula is 
copied or dragged to another cell, while 
absolute reference remains constant. 

 
$A$1, $B$3 are examples of  absolute cell 
reference. 
 

C1, D2, E4, etc are examples of  relative cell 
references.  



1. Open both Excel worksheet and PowerPoint presentation you want to edit at the 
same time. 

2. Select the cell range in Excel worksheet that you want to link/embed. 
3. Right-click on the selected cell range and click on Copy. 
4. Go to PowerPoint slide where you want to insert the data. 
5. Click on Paste in the Home tab and select one of the following options: 

▪ Use Destination Styles: copy the data as a PowerPoint table using format of 
presentation 

▪ Keep Source Formatting: copy the data as an Excel object with its original 
formatting 

▪ Picture: copy the data as an image 
o Insert clip art in Excel worksheet: 

1. Go to Insert tab in Excel worksheet. 
2. Click on Online Pictures (in Excel 2007/2010, this option is called Clip Art). 
3. Type in your search word(s) and press Return 

5.  
o  

1. View the results of your search. 
2. Double-click one of the results to add it to your worksheet. 

o Insert clip art in PowerPoint slide: 
1. Go to Insert tab in PowerPoint slide. 
2. Select Pictures, choose Online Pictures, and then in the Filters select Clip Art. 
3. Choose your preferred Clip Art and add it into the Slide. 

o Go to Animations tab and select any animation effect from there. 
o Go to Transitions tab and select any transition effect from there. 

Q16. What is the difference between Machine Language and High-Level Language? 
 
Ans: 

        Machine language               High level language 

Machine Language is the only language that 
is directly understood by the computer. 

 High Level Language uses English and 

mathematical symbols in its instructions. 

 It consists of binary strings of 0s and 1s.  It is closer to a human language like English 
and does not need to be translated. 

Machine Language is machine-dependent, 
meaning it varies from one computer to 
another 

While High Level Language is machine-
independent, meaning it can run on different 
computers 

 
Q17. Discuss about different data types of C programming Language. 
 
Ans: C programming language has several data types that are used to define variables. Each 
data type requires different amounts of memory and has some specific operations which can be 
performed over it.  
 

6. int: It is used to store integer values. It requires 2 or 4 bytes of memory depending on the system 
architecture. 
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7. Char: It is used to store a single character. It requires 1 byte of memory. 
8. float: It is used to store floating-point numbers. It requires 4 bytes of memory. 
9. double: It is used to store double-precision floating-point numbers. It requires 8 bytes of memory. 
10. void: It is used to represent the absence of type. 

Q18. Find the output of the following expressions 

a) X=20/5*2+30-5    b) Y=30 – (40/10+6) +10    c) Z= 40*2/10-2+10 

Ans: a) x=20/5*2+30-5     b) Y=30-(40/10+6) +10       c) z=40*2/10-2+10 

=4*2+30-5                           = 30 – (4+ 6) + 10                  = 80/10-2+10 

=8+30-5                               = 30 – 10                                  = 8-2+10 

=8+33                                   = 20                                           = 6+10 

= 41                                                                                          = 16 

Q19. Describe the syntax of the following statements 

a) If – else statement b) for loop c) while loop d) do-while loop 

 

 

Ans: a) if { 

                   Block of statement 

                 } 

          else { 

                      Block of statement 

                  } 

        b) for { 

                     Block of statement 

                    }  

        c) while {                  

          Block of statements 



            } 

        d) do {  

        Block of statements 

   } while  

Q20. Find the output of the following program segments 

Ans: a) output = IMS Ghaziabad 

         b) output = IMS Ghaziabad 

                              IMS Ghaziabad 

         c) output = Largest number is 100 

      

 

 

 

 

 

 
                  


